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All right - let's take a look at how you would use a spreadsheet to go ahead and do many, many,
many simulations of the roc flu problem. As we've said, pressing F9 gives you one scenario,
one result of many, many potential results. And what you're most interested in, in this problems
with stochasticity, is running many, many replicates of a particular model. And then
summarizing the results so you get a feel for what's the range of values that are possible and
also what are the most likely outcomes that are possible. And so we're going to do that by
using the ‘Macro’ function in Excel. And this is a huge time saver and a very important skill if
you're going to be doing a lot of modeling.

So we're going to set up our macro by first setting up some column headings. And so in cell
G6, I'd like you to enter the word ‘Trial’. And we are going to run 1000 trials of a roc population
with stochasticity. So if | press F9 and | look and see, well, my Ending Population Size is 626
and there was one flu epidemic, that represents one trial. If | press F9 again, there's a second
trial. If | press F9 again, there's a third trial. And you can see this would become quite a chore to
record those by hand, and so it's in your best interest to use a macro to let the computer do the

work for you.

So we're going to run 1000 trials. I'm going to start a series, and I'm going to then grab the Fill
handle and drag all the way down to the year 1000. And you want to run enough trials so that
you get a really good handle on what the variation in results could be. And truly we could run
fewer than 1000. We could a hundred, and that would be enough for you to get an idea, but
when you're doing these in a real scenario, you want to aim for a number of replicates that gives

you a really good idea of what the possible values and outcomes could be.

So there we have a trial, 1 through 1000, and what we're going to record are the number of rocs
- this is again the year 2000 - and we are also going to just record the number of flu epidemics.
Because we have that information handy and we just might want to graph, whether or not, how
many flu epidemics is most likely. You can probably guess what these graphs might look like,

just based on the numbers that are entered here, but let's go ahead and run it anyway.



A macro is just a series of recorded keystrokes that Microsoft Excel will record for you. And as
you go through a macro, it's recording your keystrokes as a set of instructions. And when you're
finished recording and then play that macro, the computer will just repeat very faithfully that
particular series of keystrokes. And so let's talk through what we'd like the computer to do, as

we do this macro, and as we press and run a simulation for roc flu.

So what we want to do first is press F9 to generate a new trial. Then we want to go over to cell
E2 and E3, copy those values, come over to Trial 1 and paste in the numbers that we just
recorded in cells E2 and E3. We're going to paste those in there. Then we want to do that
again. Press F9, take the next results, and paste them in there. Press F9, paste them in the
next results. I'm going to walk through how | typically do these kinds of macros.

First, I'm going to highlight these and give them the same border as the other parts of my
spreadsheet. And | want to point out that the macro tab is under the View tab up in the Ribbon -
and it's to the far right-hand corner and it's called Macros. And, if you click on that button, you
can see a list of the macros that are currently in your workbook. And you should have no

macros that are there at this time.

If you click on the [Macros] drop-down button, you'll see you can just view the macros. Or you
can record a new macro, and that's the button we're going to push. This option, Use Relative
Reference, is another extremely useful button to know. We're not going to need it in this

particular exercise, but we will potentially use it later on.

For us to start a new macro, we choose Record Macro, and we give the macro a name. And
let's just call this macro ‘Trial’. You can enter a shortcut key here, so that would be Ctrl-plus and
pick a letter, ‘G’. And when | press those two keys together, it's going to run the macro. | want
to store this macro in this workbook, which means | need to save this workbook as a
macro-enabled workbook. And | want to enter a description of the macro down in this particular
box. Now you'd want to get in the habit of doing this, if you were somebody who does a lot of
population modeling and would ever want to refer to your old models or share your models with
somebody else, "This macro runs the roc population model over 1000 replicates or trials." And
click OK. And now you are recording every little keystroke you make with your mouse; you are
recording that in your macro file. So if | wanted to take a trip to the end of the spreadsheet page
and back, it would faithfully record that. And that's okay; | just want you to know that you're

recording everything.



So the first thing we said we wanted to do was to press F9 and generate some new random
numbers so let's do that. There's my new random numbers. I'm going to take my mouse and
copy those cells - and | need to go back to my Home tab and press the Copy button. Then |
want to come down to cell H6. | want to find a blank cell and move into that blank cell. So | do
that by going over to the Find & Select button, and | want to just find, and | want to find the next
blank cell, but | want to search down by rows. So | want to find a blank cell within this sheet,
and | want to search down the rows as opposed to across columns. And | just press Find Next,
and the spreadsheet should go to the next cell. Now | must have clicked on something
incorrectly so I'm going to press Close. I'm going to start that again.

| can start this whole macro over again, but since | haven't really made any major mistakes, I'm
just going to keep going with this. So I'm going to press F9. I'm going to copy those values -
Copy. I'm going to select cell H1. Oh, I'm sorry. | did want to select down by columns so stay
within the same column. That was my mistake. | want to Find the next blank. And | want to
search down the column, Find Next one, and hop down to the next blank cell. | press Close.
Then | want to come up to Paste / Paste Special, and | want to paste the values. | don't want to
paste the actual formula because it won't paste correctly. And | also want to transpose those
values so that the results for one trial are in a row, and that result is pasted in there. Notice that,
when I'm pressing these buttons, Excel's keeping, generating brand new sets of random
numbers. That doesn't really matter. All we need to do is generate 1000 of these trials. In
theory, I'm done, and so | can go back to my Macro tab, click on the button, and now | have a

Stop Recording button, and | press that, and my macro has been stopped and saved.

Now what | want to do here is format these cells so that they are numbers. So again, that's
back at the Home tab, and the Numbers are going to just hide the decimal points there. Now, if
| press my Macro Control button, and mine was Control G, the macro runs and just pastes that
value straight in. And we can press that 1000 times and then we're able at this point, then, to
summarize those results. And get a really good look at — okay this is a stochastic process - and
| need to run this many, many times. And | want to look, then, across many, many trials and
see - well, what's the worse-case scenario, what's the best-case scenario. And really get a feel

for what the range and values might be.

Now there are ways to make this process easier. And, if you go back to the Macro page - let's
view that macro now. So my macro was called Trial, and what I'm going to do is edit this. And
what this does is, it pops up the visual basic code. This is Visual Basic for Applications - it's

Visual Basic that runs within an application, in this case, Microsoft Excel. This is the code. This
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is the formula, the Visual Basic code that tells the computer what instructions to do. So you can

even see this is a really nice way to quickly get a feel for what Visual Basic does.

The first thing | did was press the Calculate key. Then | selected cells E2 and E3, and | copied
them. Then | went to cell H6. | went down, and | searched by rows. That's where | made my
mistake so I'm going to take these out, and then | started the process again. So these are
where | made a mistake, and so I'm going to go ahead and delete those pieces of code. You
probably didn't make that mistake, but it's good to know you can edit your macros. So now, as |
read through this, we calculated a new trial, a new set of values. We went to cells E2 and E3,
and we copied the Ending Population Size and the ending number of flu epidemics. We went to
cell H6. We searched for the next blank cell in that particular column, then we pasted the
values into that, and then this is the end of the macro.

Now | can make my macro run way more quickly if | insert a counter button, and you can do this
by typing in the words, "For counter = 1 to 1000." And what this does is when the macro starts,
it hits this line of code. It invokes a counter. It sets it at 1. It goes all the way through this code,
and then, after it's done, it finds the word Next. And then it repeats it again, but now the
counter's incremented to 2, and it just keeps looping through this code until it hits 1000. And,
after it hits 1000, it pops out of this macro - this subroutine. And you're finished with that

particular set of instructions.
Now it looks like I'm going to close the spreadsheet, but I'm not. I'm just closing the Visual
Basic dialogue box. And now, if | run this particular macro, it's going to loop through all 2000

trials. So let's try that. I'm going to push Control G.

PAUSE the video: This is a good time for you to start working on your own macro, and seeing if

you can get it to work for you, as well.

So now we're done with our 1000 trials of the roc flu population model. And we have a whole
slough of results. And | wanted to show you a quick way to add a button to your spreadsheet.
And that would help you to just press the button to run a macro as opposed to remembering the
shortcut commands - which, | don't know about you, but | always forget them. So you can do
this in a number of ways. And what we'll do right now is, we'll go to the Insert tab, and we'll just
insert a shape. And pick any shape you like. I'm going to choose a smiley face and pop it on my
spreadsheet, and make that a little bit smaller. And if | right-click on this, then | can go down to

the Assign Macro option, and | can assign the macro Trial to that smiley face and press OK.
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Now when | press the smiley face, it's going to run that particular macro. There are other ways
to run and add buttons and forms to your spreadsheet. We won't do that right now, but we'll

probably do that in later exercises.

Now what do you need to do? Well, we've got results for 1000 trials, and we need to
summarize the data in some way. One way we can do this is by using a Frequency function
that just tracks how many trials ended up with roc populations that were between 100 and 200
or 200 and 300. And we can use the Frequency function to do that. And the Frequency
function is a different kind of function in Excel. It's called an Array function, and so it's entered a

little bit differently than other functions.

But what we need to do first is to set up what are called Bins. And I'm going to enter the word
Bins in cell K6. And I'm going to let my Bins start with the number 100 and go to 200, 300, and
let's let that go all the way up - let's just try to capture the range we see. There's a 900. Let's let
these Bins go up to, say, 1400. And what we're going to do is take our results and count how
many of all of these trials ended up with values that fit in these particular Bins. And | like to
think of the Bins as buckets. And what | need to do is look at this particular number, and here's
a bucket that holds all of the roc population sizes from zero to 100. And here's a bin that holds
all of the outcomes that were between 100 and 200. And here's a bin that holds all of the

outcomes between 200 and 300, and so on.

So what we're going to do is enter a formula that counts. Okay, here's an example from Trial 1,
and it's going to go into this bin right here. It's a number whose value falls between 300 and
400, and so it's counting a Frequency of 1. My next result also fell within that bin. This result
falls within the first bin, and the Frequency function is an easy way for you to tabulate and get a

very quick, graphical view of what your data look like.

Now to enter this Frequency function as an Array function - you don't just select one cell, you
select multiple cells at one time and then enter your function. So I'm going to select cells L7
through L20. I'm going to go up to my Insert Function button, and I'm going to search for the
Frequency button. And, once | find it, | open it up and the dialogue box asks me to choose first
the array of data, and that's going to be all the data you want evaluated. If | choose to click on
the red arrow, the dialogue box shrinks. And now I'm free to select all of my data, and I'm going
to go down and select the results for all 1000 trials. If you are keyboard shortcut person, you
can just press Control/Shift and the down-arrow, and it'll take you down to the last record very

quickly. When I'm finished, | click on the arrow again. It opens up the dialogue box, and now |
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need to enter and tell it where the Bins Array is. So I'm going to shrink this down again and go
find my Bins Array. There they are. | don't know why there's an Okay button here. Because, if
you press that, you're not going to get the right answer. What you need to do when you enter an
Array function in Excel is - you need to push the Ctrl / Shift and Enter key down at the same
time. So hold Control/Shift and Enter, and all the values will be entered and popped into those

automatically.

Now if you look up at the Formula Bar, you can tell it's an Array function because it has these
curly braces around it, and it alerts you that that function - that whole formula, is an Array, and
you can't change that Array one cell at a time. It's an equation that's working across multiple
cells at the same time.

Well, there's our results. So the caliph might be interested in knowing, for example, well how
many of these trials resulted in a population size of fewer than 100. And, if that was the case,
then you can tell him that 189 of your population runs, out of 1000 trials, resulted in a population

size of 100 or less.

And so let's go ahead and calculate that as a proportion. So our proportion is just the frequency
of the trials, out of 1000 different trials. And, if we drag this down, then you can use these
numbers in a way to talk about probability. There was an 18.9 percent probability that the
population size would fall below 100 individuals. And that's how you'd basically look at these

particular numbers.

It's often helpful to graph those. And, to graph those, you just select the Bins and the
Frequency. Go to the Insert tab, and you're going to graph this as a column chart, a 2D column.
And we don't need to graph the Bins so | can select the Bins and delete those. And what we're
graphing here is just the Frequency. | need to insert a proper set of values for the X Axis, and |

need to also label the axes as well.

To do that, | first can go to the Design tab. And | can select the data, and it pops up a dialogue
box. And I want to edit the horizontal Axis labels. So | choose the Edit button, shrink down the
dialogue box, and | choose my Bins here as the labels for my horizontal Axis and click OK. And
then click OK. And | also, at this point, need to label my Axes. And so | can choose the layout
tab, and | can find the Axis Title button. My horizontal Axis is going to be called, Roc Population
Sizes - these are our categories though - so this would be ‘Final Population Size Category’.

And then, on the vertical Axis, we'd want to put ‘Frequency’. Looks a little bit messy so | can
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drag this and make it bigger so that those categories are more clearly readable.

So those are the results of our 1000 trials. Over 150 -189 to be exact - of our trials, which
represented 18.9 percent, resulted in a roc population size that was between zero and 100.
And 23 percent, or 23.9 percent, resulted in population sizes between 100 and 200 rocs. And,
if you had run your model more times, you'd get a better idea of what the shape of this actual
graph would look like. And that's the value in running a macro is that you can do this many,

many times without too much worry or fuss.

What do you think you should report back to the caliph? Is all well with the roc flu? Or should
the Caliph be worried about this in any way?

PAUSE the video: Why don't you take a minute and write out what you think a report might be,

in just a couple of sentences.

Before we go on now, we're going to save the spreadsheet. And you'll want to save this

spreadsheet as ‘Roc Flu'.

And, for this particular spreadsheet, you don't want to save it as an Excel Workbook. You need
to select an option that allows you to enable the Macro. So you'd want to choose the option

called Excel Macro-Enabled Workbook [ .xIsm ] and click Save.

And now you have an example of how to use a macro. And also, how do you run a stochastic
model where you have an environmental factor, which is the roc flu, that behaves in a stochastic
way? And how do you use that model to assess risk to the population, in terms of getting a
good sense of what the likely outcomes are and what the likely outcomes are not? And you can
use the information from the macro to put some numbers on those particular probabilities or to

assign probabilities to those numbers.

< 00:25:48 END >



